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8

DIGITAL DOCUMENTATION

In the previous module you have learnt about basic computing. Now, in this

lesson you will learn about digital documentation. Documentation is part of our

life today. We all are very familiar with a paper document which is a document

on a paper. On the other hand, a digital document is a document that is available

in electronic form. Whether we are in school, office or business, we read printed

text in one form or another. Everyday we come across printed material in the

form of books, newspapers, magazines, notices, circulars, date sheets, tutorials,

admission forms, resumes etc. Few years back all the printed material was

available on paper but now we are moving more towards digital documentation.

This is a more convenient and eco-friendly way because we save paper and at

the same time, the document can be edited, formatted, copied and shared much

more easily as compared to printed text. Also, today, we are in a technological

era where we have books, tutorials, examination papers, newspapers etc. in

digital form.

OBJECTIVES

After reading this lesson, you will be able to:

define Word processing and Word processors;

create documents using Apache OpenOffice Writer;

save, print and close a document;

apply various editing and formatting features;

use the find and replace feature;

insert headers and footers;

create and work with tables;
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insert images and other gallery objects;

use track changes and mail merge feature;

use OpenOffice Writer help.

8.1 WORD PROCESSING AND WORD PROCESSORS

A word processor is an application software that is used for creating, editing,

formatting and printing any type of textual data. This textual data that is created

using a word processor is called a document and the process of using a word

processor is called word processing. A document may consist of text, images,

drawings, tables etc. Both paper documents and digital documents are created

using a simple text editor like Notepad or any word processor like MS Word

or OpenOffice Writer. Before the coming of Word Processors in 1980s, this work

was done either manually or using a typewriter.

8.1.1 Features of Word Processor

The following are the common features of a word processor:

(i) A word processor allows us to save a document and also to make

modifications in an already created document very easily. We can change

the appearance of the text by making it bold, italic or by changing its colour,

size or style.

(ii) Using a word processor, we can insert images, pictures, tables, etc. in our

documents.

(iii) The Find and Replace feature of a word processor allows us to find and

replace a particular word in the document.

(iv) The Spelling and Grammar check feature of a word processor helps to

make automatic corrections in the document. It also gives thesaurus

containing synonyms and antonyms of words.

(v) The OLE (Object Linking and Embedding) feature allows us to embed

objects like charts, pictures, audio, video, etc. in our document.

(vi) A word processor has a unique feature called Mail Merge which allows us

to send personalized letters, invitations etc., to multiple people.

(vii) Art gallery allows inserting a picture.

There are many word processors available in the market like MS Word,

OpenOffice Writer, WordPerfect etc. More or less all of these have all the

features required for creating a good digital document. Microsoft Word has been

the most popular word processor since many years but now with the development
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in open source software, the OpenOffice Writer is increasingly being used by

more and more users. The advantage with OpenOffice is that it can be

downloaded free of cost from Internet. One of the links from where you can

download OpenOffice Writer is www.openoffice.org. In this lesson you

will learn about digital documentation using Apache OpenOffice Writer

(version 4.1.1).

8.2 STARTING OPENOFFICE WRITER

OpenOffice Writer or simply Writer is a word processor that is part of

OpenOffice Suite. It is a What You See Is What You Get (WYSIWYG)

application which means that the print out of the document will look exactly

as we see on the computer screen.

To start Writer, follow the steps given below (Fig. 8.1):

1. Click Start button.

2. Click All programs.

3. Click OpenOffice.org

4. Click OpenOffice Writer

 

Fig. 8.1: Starting OpenOffice Writer
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The writer window appears as shown in Fig. 8.2 below.

Title bar Menu bar Standard Toolbar

Rular

Work Area

Docking Toolbar

Fig. 8.2: Writer Window

The main components of Writer window are as follows:

Title Bar: It is present on the top of Writer window and it displays the name

of the document and the name of the application (i.e. OpenOffice Writer). On

the right side of the Title bar, you will find the three Window Control buttons

to minimize, maximize/restore and close the Writer window.

Menu Bar: Below the title bar is the menu bar which contains various menu

items - File, Edit, View, Insert, Format, Table, Tools, Window and Help.

Standard Toolbar: Below the menu bar is the Standard toolbar which contains

buttons for frequently used commands such as New, Open, Save, Print,

Cut,Copy, Paste etc.

Formatting Toolbar: This toolbar consists of commands that help in formatting

the document like font style, size, colour, bold, italic, underline etc.

Work Area: It is the area where you type the text. It can hold unlimited text

which may include characters, pictures, drawings, or symbols. The vertical

blinking line in the work area is called insertion point or cursor. The location

of this cursor determines where the next character will be inserted.

Status Bar: This is located at the bottom of the Writer window and gives

information about the current document like its word count, page number,

number of pages and language used.

Scroll Bars: There are two scroll bars on the Writer Window:

Horizontal Scroll Bar: It helps to navigate the document left and right.
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Vertical Scroll Bar: It helps to navigate the document up and down.

We can click the arrows on the either side of the scroll bars to navigate through

the document.

Rulers: The Writer window has two rulers:

Horizontal Ruler: This is located at the top of the document and helps to

define indents and also the left and right margins.

Vertical Ruler: This is located to the left of the document and helps to define

top and bottom margins.

Docking Toolbars: On the extreme right of the window, Writer provides you

with four icons –Properties, Styles and Formatting, Gallery and Navigator. By

clicking on any of these icons, the corresponding docking toolbar opens

containing various buttons to format text, apply styles, insert pictures and

navigate through the document respectively.

8.3 CREATING A NEW DOCUMENT

When we start OpenOffice Writer, the Writer window opens with a new

document. But if the Writer window is already open, follow the steps given

below to open a new document:

1. Click File →  →  →  →  → New (Fig. 8.3)

2. Choose the Text Document option from the submenu. The new document

opens.

Fig. 8.3: File Menu

Press Ctrl + N to open a

new document.
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8.4 SAVING A DOCUMENT

Saving a document is necessary for future use. Also, we need to save the

document after any changes are made to it in order to retain those changes.

When we save the document, it gets stored in the hard disk of the computer.

To save the document for the first time, follow the steps given below:

1. Click File →→→→→ Save As. The Save As dialog box appears (Fig. 8.4).

Fig. 8.4: Save As dialog box

2. Browse for the folder where the file has to be saved.

3. Type the name of the file in the File name text box.

4. Click Save button. Although Writer allows us to save the document in variety

of formats but by default, the file created and saved in OpenOffice Writer

will be saved with an extension .odt.

Thereafter, the name of the file will

appear on the title bar of the

document.

We can also save the document by clicking on Save button on the Standard

toolbar (Fig. 8.5). Please note that the Save As dialog box appears only when

we are saving the document for the first time. However, if the same file has

to be saved with a different name or at a different location, then select Save

As option again from the File menu.

Press Ctrl + Shift +S to save

document for the first time and

Ctrl+S to save otherwise.
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Save button

Fig. 8.5: Save button

8.5 PRINTING THE DOCUMENT

After creating the document, we might need to print it on paper. Before starting

the process of printing, make sure that the printer is connected to the computer

and then follow the steps given below:

1. Click File → → → → → Print. The Print dialog box

appears (Fig. 8.6).

2. The left hand side of the Print dialog box contains the Preview of the

document that helps to see how the document will look when it is printed.

On the right side, there are various tabs. From the General tab, select the

type of Printer, number of copies that have to be printed and then click on

Print button.

Preview Type of printer

Fig. 8.6: Print dialog box

Press Ctrl +P to open the

Print dialog box.
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To print directly without opening the Print dialog box, click Print File Directly

button on the Standard Toolbar (Fig. 8.7).

Fig. 8.7: Print File Directly Button

Before printing, to see the document as to how it will look on the paper, select

Page Preview button from the File menu. The Page Preview screen appears

(Fig. 8.8).

Fig. 8.8: Page Preview

We can zoom in and zoom out the document in this view. To go back to the

normal view, click Close Preview button.

8.6 CLOSING OPEN OFFICE WRITER

After finishing our work, we can close the document without closing the Writer

window by selecting Close option from the File menu.
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If we want to exit Writer, click Close button ( ) on

the top right corner of the Writer window. Alternatively

we can click File →→→→→ Exit option.

In either of the ways described above, if our document to be closed is not saved,

then Writer prompts to save the document by displaying a message box as shown

in the Fig 8.9.

Fig. 8.9: Message Box to Save the document

Click Save button to save, Discard button to close the document without saving

and Cancel button to cancel the closing process and continue working with the

current document.

8.7 OPENING AN EXISTING DOCUMENT

To open an already saved document in Writer, navigate to the folder where the

file is saved and then double click to open it. However, if the Writer window

is open, we can follow the steps given below to open the file:

Fig. 8.10: Open dialog box

Press Ctrl +Q to exit

Writer.
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1. Click File →→→→→ Open. The Open dialog box will appear (Fig. 8.10).

2. Browse the folder in which your file is saved.

3. Select the file to be opened. The name of the

file appears in the File Name text box.

4. Click Open button and the document will be displayed in the Writer window.

8.8 EDITING A DOCUMENT

Editing is the process of making changes in the document in any manner. It may

be by changing the contents, by rearranging words or paragraphs, by correcting

mistakes or by even by changing the appearance of the text.

OpenOffice Writer provides us with various options to modify our document.

But first, the text to be modified has to be selected.

8.8.1 Selection of Text

We can use either a keyboard or a mouse to select any text in the document.

Using a Mouse:Keep the mouse pointer in the beginning of the text(for

example, a character, word or paragraph) that you want to select. Click and

drag the mouse pointer till the entire text is selected. The selected text (Open

Source Software in Fig. 8.11) is highlighted in blue colour.

Fig. 8.11 : Selected text in blue colour

Using Keyboard:To select the text using a keyboard, place the cursor before

the text that you want to select. Holding down the Shift key, press one of

the arrow keys in the direction of required selection. Also, there are various

shortcut keys available to select the text. The table 8.1 lists some of these.

Press Ctrl +O to open an

existing document.
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Table 8.1: Shortcut keys for selecting the text

Shortcut Key Selection

Shift + End To select the line from cursor position to end of the line.

Shift + Home To select the text from the cursor position to the beginning

of the line.

Ctrl + Shift + ↓ To select the text in a paragraph from the cursor position to

the end of the paragraph.

Ctrl + Shift + ↑ To select the text in a paragraph from the cursor position to

the beginning of the paragraph.

Ctrl + Shift + Home To select the text from the cursor position to the beginning

of the document.

Ctrl + A To select the complete document.

8.8.2 Copying Selected Text

Copying text means to duplicate the text. The text is present at the original place

and at the same time we paste it at a new location also. Any text on the document,

may it be character, word, sentence or paragraph can be copied by following

the steps given below:

1. Select the text that has to be copied.

2. Click Edit →→→→→ Copy.

3. Place the cursor where the text has to be pasted.

4. Click Edit →→→→→ Paste.

8.8.3 Moving Selected Text

While copying, we place the duplicate text at the new position but while moving

the selected text, the text is removed from the original location and pasted at

a new location. The steps to move the text are as follows:

1. Select the text that you want to move.

2. Place the mouse pointer anywhere on the selected text.

3. Drag the selected text to the desired place.

You may also use the Cut, Copy and Paste buttons on the Standard toolbar

(Fig. 8.12) to cut, copy and paste the text in the document respectively.

Alternatively, if we right click on the selected

text, a pop up menu will be displayed.

Select Copy, Cut or Paste options as

required.

Press Ctrl +C to copy, Ctrl + X

to cut and Ctrl + V to paste the

selected text.
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Cut Copy Paste

Fig. 8.12: Cut, Copy and Paste buttons Standard toolbar

8.8.4 Deleting the selected text

To delete the selected text, perform the following steps:

1. Select the text to be deleted.

2. Press Delete key on the keyboard. The selected text gets deleted.

8.9 FINDING AND REPLACING TEXT

The Find and Replace feature of Openoffice Writer helps us to search for a

particular word, phrase or sentence in a document and replace it, if required.

The replacements may be done once or for multiple number of times.

To find a word in your document follow the steps given below:

1. Click Edit → → → → → Find and Replace (Fig. 8.13). The Find and Replace dialog

box appears (Fig. 8.14).

Fig. 8.13: Find and Replace option
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Fig. 8.14: Find & Replace dialog box

2. Type the word (team in our example)to be found in the Search for text box.

3. If the word that is being searched has to be in the particular case only, select

Match case option. If we want to search only complete words click Whole

Words only option.

4. Click Find button. The first occurrence of the typed word (team) gets

selected in the document as shown in the Fig 8.14.

5. To find more occurrences of the word, keep on clicking the Find button

till the last occurrence of the word is displayed. A message box stating that

‘End of the document has been reached’ and whether you would like to

start the search again from the beginning will be displayed. Click Yes button

in the message box to resume the search

from the beginning of the document and

No otherwise (Fig. 8.15).

 

Fig. 8.15: Message box on completing the search

6. Click Close button to close the Find and Replace dialog box at any point

of time.

Press Ctrl + F to open the Find

& Replace dialog box.
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8.9.1 Replacing Text

To replace the text, open the Find and Replace dialog box as explained above

and then perform the following steps to replace the character, word or phrase

with some other character, word or phrase.

1. Type the word to be replaced in the Search For text box (team in our

example).

2. Type the new word that we want to replace with in the Replace With text

box (say, group).

3. Click Replace button if only one occurrence of the found word has to be

replaced. However, to replace all the occurrences of the word, click Replace

All button.

Fig. 8.16: Finding and Replacing text

8.10 FORMATTING THE DOCUMENT

The process of improving the appearance of text in a document by changing

text alignments, font, size, style etc. is called formatting. It helps in highlighting

headings and other such important text by differentiating it from regular text.

Formatting can be of three types –

Character Formatting

Paragraph Formatting

Page Formatting
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8.10.1 Character Formatting

This type of formatting is used for individual characters or set of characters in

a document. It includes applying font style, size and other text attributes viz.

bold, italic, underline etc. To apply character formatting, follow the steps given

below:

1. Select the text to be formatted.

2. Click Format →→→→→ Character option. The Character dialog box appears

(Fig. 8.17).

Fig. 8.17: Character dialog box

3. By default, the Font tab is selected. From the Font list box, select the

desired font. The preview of the selected font is seen at the bottom of the

Character dialog box.

4. Similarly select the font size, typeface

and other text attributes.

5. Click OK to apply the selected effects

and close the dialog box.

The Formatting toolbar (Fig. 8.18) on the Writer window contains buttons to

apply various formatting effects to the text in our document. Select the text on

Press Ctrl +B, Ctrl + I or Ctrl +

U to make the text bold, italic or

underline respectively.
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which the formatting effects are to be applied and then choose the appropriate

button from the toolbar. For example, to make the text bold, click the Bold

button after selecting the text.

Fig. 8.18: Formatting toolbar

8.10.2 Changing Case

Text in OpenOffice Writer can be written in any of the following five types of

cases:

Sentence Case: First letter capital (My country)

Upper Case : Capital alphabets  ( MY COUNTRY)

Lower Case: Small Alphabets ( my country)

Capitalize Every word: First letter of every word is capital ( My Country)

Toggle Case: reversing the existing case

 

Fig. 8.19: Change Case option

To apply a particular case, select the text and click Format →  →  →  →  → Change

Case (Fig. 8.19). Click on the desired case option to be applied to the selected

text.
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8.10.3 Paragraph Formatting

To format a paragraph we can set its right, left, top and bottom margins, align

the text, set indents and spacing between the text and lines and so on. The

Formatting toolbar contains buttons to apply various formatting effects to the

document (Fig. 8.18).

Text Alignment: The Formatting toolbar has the buttons to align the text in four

ways – Left, Right, Center and Justify. Select the paragraph and then click on

the desired alignment button on the Formatting toolbar.

Indentation and Spacing: Indentation refers to the blank spaces in the beginning

of the paragraph and Line Spacing refers to space between two or more lines

in a paragraph. A document with increased line spacing has good readability but

at the same time consumes more space. By default, all indents and spacings are

measured in centimetres (cms) in OpenOffice Writer. Perform the following steps

to set line spacing and Indentation:

1. Select the paragraph whose line spacing has to be set.

2. Select Format → → → → → Paragraph. The Paragraph dialog box appears

(Fig. 8.20).

Fig. 8.20: Paragraph Dialog Box
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3. Select Indents and Spacing tab in the Paragraph dialog box.

4. Set the Indents in the Indents section. The indent options available are:

Left indent: This moves the text to

the left side of the document. We

have to specify the Before Text

value in the Indent section.

Right indent: This moves the text to the right side of the document. We

have to specify the After Text value in the Indent section.

First Line indent: This moves only the first line of the paragraph to the

right.

Hanging Indent: The first line is less indented than the rest of the

paragraph.

5. From the Line Spacing List Box, select the desired line spacing.

6. Click OK button.

8.10.4 Page Formatting

Page formatting includes giving desired settings to essential elements of the page

such as page size, orientation and margins. To apply Page formatting effects

follow the steps given below:

1. Click Format → → → → → Page. The Page Style Default dialog box is displayed

(Fig. 8.21).

Fig. 8.21: Page Style Default dialog box

Increase Indent or Decrease

Indent buttons on the Formatting

toolbar can be used to indent the

paragraphs.
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2. Select the Page tab and in the

Paper Format section:

(a) Select the required page

size from the Format List

box.

(b) Select the Orientation by selecting either Portrait or Landscape radio

buttons.

3. From the Margins section, set top, bottom, left and right margins of the

page.

4. Click OK button to apply the selected

Page formatting effects.

INTEXT QUESTIONS 8.1

1. Define Word Processor. Name any two word processors.

2. Fill in the blanks.

a. To view the document before printing, click ................... option from

the File menu.

b. The case in which first letter of the sentence is capitalized is called

...................

c. The Find and Replace option is in ................... menu.

d. The shortcut key to select the text in a paragraph from the cursor position

to the end of the paragraph is ...................

e. The vertical blinking line in the work area whose location determines

where the next character will be inserted is called ...................

3. Multiple Choice Questions

(i) Which of the following is the shortcut key to save the document for the

first time in Writer?

(a) Ctrl + S (b) Shift +S

(c) Ctrl + Shift +S (d) None of the Above

(ii) Which of the following is not the type of formatting in Writer?

(a) Character (b) Line

(c) Paragraph (d) Page

In the Writer window, click and

drag the margin indicators on

the rulers to set the page

margins.

The Properties Toolbar on the extreme

right of the Writer window contains

various commands to apply character,

paragraph and page formatting to the

document .
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(iii) Using which of the following methods can you open the Find & Replace

dialog box?

(a) Pressing Ctrl + F (b) Select Format →→→→→ Find & Replace

(c) Both (a) and (b) (d) Neither (a) nor (b)

8.11 HEADERS AND FOOTERS

In multipage documents, you may need to put some additional information like

page numbers, author’s name, date of creation of the document etc. on the top

or bottom of the page. Such information inserted at the top of the page is called

header and that inserted at the bottom of the page is called footer. To insert

header or footer in the document, follow the steps given below:

1. Click Insert →→→→→ Header/Footer →→→→→ Default.

2. The cursor appears in the Header/Footer section of the document. Type the

desired text in the Header/Footer. In Fig. 8.22, the text ‘National Institute

of Open Schooling’ is inserted as a header.

Fig. 8.22: Document with Header

8.12 INSERTING PAGE NUMBERS

To insert page numbers, position your cursor at the place where page number

has to be inserted. It may be in the main document or in the header or footer

area. Select Insert →  →  →  →  → Fields →  →  →  →  → Page Number (Fig. 8.23).
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Fig. 8.23: Insert Page Number option

8.13 INSERTING SPECIAL CHARACTERS

To insert special characters in the document, follow the steps given below:

 Fig. 8.24: Special Characters dialog box
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1. Place the cursor at the place where the special character has to be inserted.

2. Select Insert →→→→→ Special character. The Special Character dialog box is

displayed (Fig. 8.24).

3. Click on the desired symbol and then click OK button. The selected symbol

will be inserted in your document.

8.14 BULLETS AND NUMBERING

Bullets and Numbering feature of OpenOffice Writer helps us to present the

information in the form of lists. The bulleted list contains various styles of bullets

like circles, squares, arrows etc. while the numbered list contains alphabets and

numbers. To use the Bullets and Numbering feature, follow the steps given

below:

1. Select the paragraph or text to which the bullets have to be applied. If the

text is not typed, place the cursor at the position from where you want to

start the list.

2. Click Format →→→→→ Bullets and Numbering. The Bullets and Numbering

dialog box appears (Fig. 8.25).

 Fig. 8.25: Bullets and Numbering dialog box
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3. By default, the Bullets tab is selected. Select the desired bullet style.

Otherwise click the Numbering Type tab and select the desired numbering

style.

4. Click OK button. The bullet/numbering style will appear in the document.

8.15 SPELLING AND GRAMMAR CHECK

Using Spelling and Grammar Check feature of Writer, we can find and correct

spelling and grammatical errors in our document easily. It even allows us to

create personal and custom dictionaries to store words that are not available

in the built-in dictionaries. The two ways of checking Spelling and Grammar

in Writer are:

8.15.1 Auto Spell Check

This feature, when activated, automatically underlines possible spelling mistakes

with a red wavy line. Click Auto Spell Check button ( ) on the Standard

toolbar to activate this feature. If you right click on the underlined word, Writer

gives possible suggestions to select from. Just click on the spelling that you feel

is correct to replace the misspelt word. In Fig. 8.26, the word ‘vendor’ is

wrongly spelt as ‘vendr’ and hence is shown with a red wavy line. The Fig. 8.26

shows the possible suggestions to correct it.

 

Fig. 8.26: Suggestions for correction

To add the misspelled word to Writer’s standard dictionary, click the Add →→→→→

standard.dic option from the drop down menu as shown. If AutoCorrect

option is selected, Writer will automatically correct the misspelt word.
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8.15.2 Using Spelling and Grammar option

To use this method of checking spelling and grammar in your document, follow

the steps given below:

1. Place the cursor at the beginning of the document.

2. Click Tools → → → → → Spelling and Grammar.

a. The Spelling: English (USA) dialog box appears (Fig. 8.27).

 

Fig. 8.27: Spelling: English(USA) dialog box

b. The misspelt word (vendr in Fig 8.27) will be displayed in red colour

in the ‘Not in dictionary’ section. The suggestions for correction are

given in the lower portion of the dialog box. Perform either of the

following steps:

i. To accept the suggested word, click the suggested word and then

click Change button

ii. Edit the word or phrase manually in

the upper text box and then click

Change button.

iii. Click Add button to add the word in Writer’s dictionary.

iv. Click Ignore button if you want to ignore the spelling error indicated

by Writer.

c. After all the spelling errors are removed, a message box is displayed

stating that the Spelling and Grammar check is complete. Click OK

button.

d. Click Close button in the Spelling: English (USA) dialog box to close

the dialog box at any time in between.

Press F7 to start the Spelling

and Grammar check
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8.16 GRAPHICS IN WRITER

Graphics make the document more attractive, informative and presentable.

OpenOffice Writer provides various options to add graphics in the document.

We can add graphics by drawing objects and inserting pictures.

8.16.1 Drawing Objects

The Drawing toolbar contains various commands to draw lines, curves, shapes,

callouts, symbols, flowcharts, graphic fonts etc. in the document. Therefore, to

insert drawing objects first click View → → → → → Toolbar → → → → → Drawing to display the

Drawing Toolbar (Fig. 8.28).

Fig. 8.28: Drawing Toolbar

Click to select any of the object and then click and drag the mouse in the work

area to draw the selected object. The toolbar contains buttons for colouring,

inserting patterns, borders and various other commands to enhance the

appearance of drawing objects. Fig. 8.29 shows various drawing objects that

have been inserted using the Drawing toolbar.

Fig. 8.29: Drawing Objects inserted in the document

8.16.2 Inserting Pictures

To insert a picture in a Writer document perform the following steps:

1. Click the Tools →→→→→ Gallery button. The Picture gallery is displayed (Fig.

8.30).

2. The pictures are categorised according to various themes. On selecting any

of the themes from the left side of the gallery, the corresponding pictures

are displayed on the right side. Select the desired theme and then the desired

picture.



Computer Science

MODULE – 2 Digital documentation

 138

Office Automation

Notes

3. Right click the picture that you want to insert and select Insert ® Copy

from the drop down menu (Fig. 8.30).

Fig. 8.30: Inserting a picture

4. The picture will be inserted in the document (Fig. 8.31). We can resize the

picture by clicking and dragging the size handlers.

 

Fig. 8.31: Inserted Picture in the document

Click Gallery button ( ) on the extreme right of Writer Window to display

the picture gallery (Fig. 8.31).

As the picture is inserted, the Picture toolbar is displayed on the screen (Fig.

8.31). The various commands on this toolbar can be used to enhance the

appearance of the inserted picture.
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8.17 WORKING WITH TABLES IN WRITER

A table is a grid of rows and columns. It helps to present data in row and column

format. Follow the steps given below to insert a table in the document:

1. Click Insert → → → → → Table. The Insert Table dialog box appears (Fig. 8.32).

Fig. 8.32: Insert Table dialog box

2. Type the name of the table in the Name text

box..

3. Choose the number of rows and columns

from the respective list boxes.

Fig. 8.33: Table inserted in the document

The shortcut key to open the

Insert Table dialog box is

Ctrl + F12.
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4. Click OK button. The table with specified number of rows and columns will

be inserted in your document (Fig. 8.33). As the table is inserted in the

document, the Table toolbar is also displayed (Fig. 8.33). This toolbar

contains various commands to edit/format the table.

5. Click in any cell of the table to enter data. Other than the mouse, the

following keys can be used to move in the table:

Tab : to move one cell to the right

Shift + Tab : to move one cell to the left

Up Arrow: to move up by one row

Down Arrow: to move down by one row

8.17.1 Inserting a row and column in a table

1. To insert a row or column in a table, right click the cell above which you

want to insert a row or beside which you want to insert a column.

2. From the drop down menu, select the Row or Column option.

3. Select Insert option from the submenu.

4. The Insert Row or Insert Column dialog box is displayed (Fig. 8.34).

 

Fig. 8.34 : Insert Row dialog box

5. Choose the number of rows or number

of columns to be inserted.

6. Also choose the position of the rows or

columns to be inserted i.e., before or

after the current cell.

7. Click OK. The specified number of rows/columns will be added to the table.

8.17.2 Deleting Row or Column from a table

1. To delete a row or column in a table, right click a cell in the row/column

that you want to delete.

2. From the drop down menu, select the Row or Column option.

3. Select Delete option from the submenu. The selected row/column will be

deleted.

Click Table button ( ) on the

Standard Toolbar to insert a

table.
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8.17.3 Formatting a Table

Formatting a table means changing the appearance of the table. This can be done

by applying/changing the colour of the text, cells or border or even by altering

the thickness of the border. Writer allows us to automatically format the table

by selecting Table →  →  →  →  → Auto Format option. In the Auto Format dialog box

(Fig. 8.35) that appears, set the desired format and click OK button.

 Fig. 8.35: AutoFormat dialog box

8.18 TRACK CHANGES

Sometimes, our document may be used and edited by multiple users. To track

or record the changes made by each user, Writer provides the Track Changes

feature. When this feature is enabled in the document, we can view all the

previous versions of the document. This is because Writer keeps track of all

types of changes that have been made by any user in the document. Perform

the following steps to use the Track Changes feature in the document:

1. Click Edit →→→→→ Changes →→→→→ Record. This enables the process of recording

changes in the document. Now, whatever modifications are made to the

document, will appear as coloured text.

2. Make some changes in the document, say inserting or deleting any text or

applying some formatting effects. In the example shown in Fig. 8.36, the

word ‘appropriated’ has been deleted and the word ‘owned’ has been added.

3. The inserted text will be displayed in different colour. The deleted text is

also displayed in a different colour and also gets striked through. Also when

we keep the mouse pointer on the changed text, a tooltip showing the name

of the user who has made the change along with date and time of making

the change is displayed.



Computer Science

MODULE – 2 Digital documentation

 142

Office Automation

Notes

Fig. 8.36: Recording the changes

8.19 MAIL MERGE

Mail Merge is a feature that helps to generate personalized letters, memos, labels

etc. This feature is helpful when similar information has to be sent to large

number of people. The text (for example, name, address, etc.) from a single data

source is combined with another document containing the main content. This

feature saves lot of time as there is no need to type separate letter for each

recipient. We can also produce labels or envelopes containing names and

addresses of different persons in one go.

The three main components of Mail Merge feature are:

(i) Data Source: This refers to the database that generally stores the names,

addresses and other personalized information in tabular format.

(ii) Main Text document: This contains the main body of the letter.

(iii) Merged Document: This refers to the document that is generated after

merging the information of the main text document and the data source.

Let us now create a document using Mail Merge feature of OpenOffice Writer.

It broadly consists of two steps – Creating a data source and merging the

document with the data source

STEP I: Creating a data source

1. Select File →→→→→ New →→→→→ Database as shown in the figure. The database wizard

starts (Fig. 8.37).
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Fig. 8.37: Starting Database Wizard

2. Select Create New Database option and click Next button.

Fig. 8.38: Finish button

3. Click Finish button (Fig. 8.38). This finishes the process of creating a

database. The Save As dialog box appears.
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4. Type the name of the database (db1, in our example) in the Name text box.

Also specify the location where you want to save the database and then click

Save button. By default, the database is saved with an extension .odb. The

new database window appears and the Tables option in the Database pane

is automatically selected (Fig. 8.39).

 Fig. 8.39: New Database Window

5. In Tasks pane, select the Use Wizard to Create Tables option. The Table

Wizard starts (Fig. 8.40). Notice that there are two panes in the Table Wizard

dialog box, on the left is of Steps and on the right are the tasks associated

with each step. The first step is Select Fields that is selected in the Steps

pane. On the right pane, it asks to Select Fields for your table.

Fig. 8.40: Step 1- Select Fields
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6. Select the Category for your table. In our case we select Personal.

7. Select the desired table (say, Authors) from the Sample Tables list box.

8. Select the required fields from the Available Fields list box. To select a

field, click the field and then click > button. In our example, we have selected

AuthorId, FirstName and LastName.

9. Click Next button. The second step Set Types and Formats gets activated

(Fig. 8.41).

Fig. 8.41: Step 2-Set Types and Formats

10. Click Next button. The Set Primary key page appears (Fig. 8.42).

 

Fig. 8.42: Step 3-Setting Primary Key
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11. Click Next button. The Create Table Page appears (Fig. 8.43).

Fig. 8.43: Step 4-Create Table page

12. Type the table name in What do you want to name your table? text box.

We have named it as Library.

13. Click Finish button. The new Table Data View window opens. Add few

records in respective fields of your table as shown in the Fig. 8.44.

14. After entering the entire data press Ctrl + S to save the table then close the

Table Data view window. Now your data source is ready to be merged in

the main document.

Fig. 8.44: Table Data View window
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STEP II: Merging the document with data source

After creating the data source, let us now create the main document, which

contains the text that is same for all recipients and also personalized information

for each recipient. The steps are as follows:

1. Open Blank Document in Writer and type the required text.

2. Click Insert → → → → → Fields →→→→→ Other option to insert fields in the main document.

The Fields dialog box appears (Fig. 8.45).

Fig. 8.45: Fields Dialog box

3. Select Database tab from the Fields dialog box.

4. To view the list of tables created in our database, double click on the database

name(db1 in our example). Select the name of the table i.e., library in our

example.

5. Select Mail Merge fields option from the Type pane of the Fields dialog

box.

6. Click Close button. We will be back in the main document.

7. In the main document click Data Source button ( ) on the Standard

toolbar. The data source with the table containing records is displayed above

the main document (Fig. 8.46).
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Fig. 8.46: Data Source above the main document

8. Drag the fields from the Data Source to the desired location in the main

document.

9. Select Tools →→→→→ Mail Merge Wizard. The Mail Merge wizard starts

(Fig. 8.47). The Steps pane on the left side of the wizard displays the eight

steps to be followed for Mail Merge. The right side of the wizard displays

the actions to be performed in each step. The first step is to Select Starting

document. On the right side, ‘Use the current document’ option is selected.

Fig. 8.47: Mail Merge Wizard (first step)
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10. Click Next button.

11. Select the type of document (Fig. 8.48) and click Next button.

Fig. 8.48: Selecting the document type

12. If you want to select an address list, click Select Different Address List

button otherwise click Next button (Fig. 8.49).

Fig. 8.49: Selecting Address block
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Fig. 8.50: Creating a salutation

13. Specify whether you want to create a salutation (Fig. 8.50) otherwise click

Next button.

14. Click Edit Document if you want to modify the main document otherwise

click Next button.

Fig. 8.51: Personalize document
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15. Click Next button if you do not want to personalize each document.

Fig. 8.52: Save, print or Send Document

16. Select whether you want to save, print or send the document to mail.

Thereafter click Save starting document button. The Save As dialog box

appears.

17. Specify the name and location of the merged document and click Save

button.

18. Click Finish button on the Mail Merge Wizard. You will see that the merged

documents are displayed.

8.20 GETTING HELP IN WRITER

Help feature of OpenOffice Writer provides us the information on various

commands available in this word processing software. It lists the use and the

steps to use any of the features/options seen in the Writer window.

Writer Help can be used offline as well as online. Though Writer’s offline help

feature is quite comprehensive, yet the online help from Openoffice.org provides

some additional help materials such as tutorials, demos, quizzes etc. To use the

offline help from the Writer Help window, follow the steps given below:

1. Click Help →→→→→ Openoffice.org Help. The OpenOffice.org Help Window

appears (Fig. 8.53).
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Fig. 8.53: Writer Help Window

2. Select the contents tab in the Help

window. The list of contents is

displayed from where we can

select any topic by double

clicking on it.

3. If there are any subtopics, double click to select any one of these. The

information related to the selected topic will be displayed.

4. Click Close button on top right of the Help

window to exit.

INTEXT QUESTIONS 8.2

1. Fill in the blanks:

(i) The additional information inserted on the top of the page constitutes

................... while that at the bottom of the page constitutes ...................

(ii) The Bullets and Numbering option is in ................... menu.

(iii) Press ................... to open Writer help window.

(iv) The Auto Spell Check button is present on the ................... toolbar.

(v) ................... key(s) are pressed to move one cell to the left in a table.

.Press Shift+F1. The mouse pointer will

change to \?. Now click on any tool in

the Writer window. A tooltip containing

information about that tool will be

displayed.

Press F1 to open Writer

Help window.
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2. Name the two ways in which Spelling check can be done in OpenOffice

Writer.

3. Write the steps to insert a picture in your document.

4. Name the three components of Mail Merge feature in OpenOffice Writer.

5. Write the shortcut keys for the following:

a. To open a new document

b. To open Find & Replace dialog box

c. To save the document for the first time

d. To exit Writer

e. To open Table dialog box

WHAT YOU HAVE LEARNT

Word processor is an application software that is used for creating, editing,

formatting and printing any textual data.

Word processor has a unique feature called mail merge which allows us to

send personalized letters, invitations, etc., to multiple people.

Page formatting includes giving desired settings to essential elements of the

page such as page size, orientation and margins.

Bullets and numbering feature of OpenOffice Writer helps us to present the

information in the form of lists.

Using spelling and grammar check feature of Writer, we can find and correct

spelling and grammatical errors in our document easily.

A table is a grid of rows and columns. It helps to present data in row and

column format.

Mail merge feature helps to generate letters, memos, labels etc. It is helpful

when similar information has to be sent to large number of people.

TERMINAL EXERCISE

1. Define word processing.

2. Write any three features of a word processor.

3. Differentiate between copying and moving a text.

4. What happens if you select Match Case option in the Find & Replace dialog

box?

5. Name the types of cases in which text can be written in OpenOffice Writer.
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6. Write the steps to insert line spacing and indentation in a paragraph.

7. Write the steps to create a numbered list in your document.

8. How can you add a word in Writer’s standard dictionary?

9. Explain the Track Changes feature of OpenOffice Writer.

10. Write the steps to create a data source for using the Mail Merge feature

in Writer.

ANSWERS TO INTEXT QUESTIONS

8.1

1. A word processor is an application software that is used for creating, editing,

formatting and printing any type of textual data. Examples of word processor

are OpenOffice Writer and MS Word

2. (a) Page Preview (b) Sentence Case (c) Edit

(d) Ctrl+Shift+ ↓ (e) Cursor

3. (i) c (ii) b (iii) a

8.2

1. (i) Header, footer (ii) Format (iii) F1 (iv) Standard (v) Shift + Tab

2. AutoSpellCheck and Spelling & Grammar option in Tools menu

3. (i) Click the Tools →→→→→ Gallery button. The Picture gallery is displayed.

(ii) Select the desired theme and then the desired picture.

(iii) Right click the picture that you want to insert and click Insert →→→→→

Copy from the drop down menu.

(iv) The picture will be inserted in the document.

4. The three main components of Mail Merge feature are:

a. Data Source

b. Main Text document

c. Merged Document

5. a. Ctrl + N

b. Ctrl + F

c. Ctrl + Shift + S

d. Ctrl + Q

e. Ctrl + F12


